iINndows

This quickstart will help you set up your MS Windows machine to explore the sourcecode of
Bonsai or develop and debug your blender scripts in VSCode. This has the benefit of having
a complete development environment where you can explore the code, make changes,
debug (break-points, watch variable and stack contents, etc. ) and see the results in blender

e Steps 1-6 will get you started with VSCode to develop and debug python scripts in
Blender and explore the Bonsai sourcecode and documentation.

e Steps 7-14 will allow you to interact with GitHub to make changes to the Bonsai project.

We will be using Windows 11 as our operating system and Visual Studio Code as our
Integrated Development Environment (IDE) and we will create a dedicated user for
Development.

/" Note

In the following steps we wil be installing a number of applications. There are several ways to install them and
that has impact on whether Windows is able to find the relevant binaries. In general if you have issues in the
stpes below related to not being able to find binaries, please check that the installation path is in the PATH
environment variable. You can hit “Windows” key and write “environment variables”.

) environment variables

Microsoft Bing Apps Documents Settings Folders Photos

Best match

Edit the system environment
g2

™ variables =

Control panel

Edit the system environment variables
Settings Control panel

gea Edit environment variables for
“ your account

And then go to [System Properties » Advanced ~Environment Variablesj.

Check that the installation path is in the PATH variable. If not, you can add it by clicking in the .

r

User variables for falke

Variable Value

ChocolateylastPathUpdate  133874001926539118

OneDrive C\Users\falke\OneDrive

Path C:\Users\falke\AppData\Local\Microsoft\WindowsApps;C:\Users... |
TEMP C\Users\falke\AppData\Local\Temp

TMP C\Users\falke\AppData\Local\Temp

New... Edit... Delete
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System variables

Variable Value

NUMBER_OF_PROCESSORS 16

0S Windows_NT

Path C\Python313\Scripts\;C:\Python313\;C:\Windows\system32;C\\...
PATHEXT .COM;.EXE;.BAT;.CMD;.VBS;.VBE; JS;.JSE;. WSF;,.WSH;.MSC;.PY,.PYW

PROCESSOR_ARCHITECTURE AMDG64

PROCESSOR_IDENTIFIER AMD64 Family 25 Model 33 Stepping 0, AuthenticAMD
PROCESSOR_LEVEL 25

PROCFSSOR RFVISION 2100

New... Edit... Delete

oK Cancel

1. Create Development User: Open Windows Settings (typically hitting “Windows” key and

writting “settings” in the search field) and then go to (Accounts » Other users]. Click on

and then add a new user. We will name it falken10Ovdl.

& Settings

e o Accounts > Other Users
falken10vdi@gmail.com

Other users

Find a setting ¢
T
A Home

M system

v

Bluetooth & devices

Network & internet =* Microsoft

Create account

3
-
/ Personalization
me

Apps

|; Accounts
& Time & language
@ Gaming
Accessibility
urity

Windows Update

2. Install Blender for the created user: We will install blender locally in the users home
directory. We must check that we are following the Systems requirements.

We will download Blender 4.2 from the Blender download page. In particular, we take the
4.2 LTS for Windows.

We will download the Windows - Portable (.zip) version:
https://www.blender.org/download/release/Blender4.2/blender-4.2.8-windows-x64.zip

Unzip the file in the user home directory. In our case it is C:
|\Users\falke\Documents\blender-4.2.8-windows-x64 (the user falken10vdl has as home
directory C:\Userslfalke).

CONGRATULATIONS! You have now Blender installed locally in your machine. You can
launch it by double clicking in blender.exe which is situated in the previous folder.

Now install the Bonsai Blender extension. Follow the Unstable installation.

CONGRATULATIONS! You have now the Bonsai Blender extension installed in your local
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Blender installation.

3. Install VSCode: Log in as the new created user (falken10vdlin this example) and install
Visual Studio Code.

4. Adjust Python version in VSCode as in Blender: This is a good practice step to ensure
that the Python version in VSCode matches the one in Blender.

Check the Python version in Blender by going to |Scripting|. In the Python Console you can
see the version number of the Python interpreter

(Unsaved) - Blender 4.2.7 LTS
D File Edit Render Window Help Mode 3 : Ediing  Texture Pain ading  Animat Rendering  Composit Geometry Nodes _ Scripting  BIN

ObjectMode v View Select Add Object [ Global v View emplates B> + New @& Open I v §
a0 optons

User Perspective

(1) Scene Collection

sy & scene

Builtin Modu (3 RenderEngine EEVEE

& v sampling
@ v Viewport
& Samples 16
¥ Temporal Repro...
Jittered Shadows
v Render
Samples
> ¥ Shadows
> Advanced
> Clamping
> Raytracing
> Volumes

> Curves

In our case it is version 3.11.7

We will need to install the closest version in our Linux machine.

We check in either in Microsoft store or Python Downloads.

The closest version is 3.11 in Microsoft Store. So we installing by clicking in .

After this, we have the 3.11 python version installed in our machine. It is reachable by
typing python3.11 in the terminal.

python3.11 -V

Command Prompt

C:\Users\falke>python3.11l —--version

Python 3.11.9

C:\Users\falke>

Finally create a sample python file and check the Python interpreter version in the bottom
left corner. Select the Python interpreter that matches the one in Blender. In our case it is
3.11.

(EZIA - NlAana, Cil A [ TS PPV EZIAW
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“ NO FOLDER OPENED -+ Create Virtual Environment.

Select Interpreter

B3 Enter interpreter path
£8% Use Python from ‘python.defaultinterpreterPath’ setting
Open Folder Python 3.13.2 64-bit C:\Python313\python.exe Recommended

Python 3.11.9 64-bit (Microsoft Store)
Opening a folder will close all currently opeii editors. 10 keep

You have not yet opened a folder.

them open, instead

You can clone a repository locally.

Clone Repository

You can open a remote repository or pull request without cloning

Open Remote Repository

To learn more about how to use Git and source control in VS Code

> OUTLINE
> TIMELINE
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CONGRATULATIONS! You have now a Python version in VSCode similar to the one run by
Blender.

5. Connect VSCode to Blender by means of VSCode’s extension: “Blender Development”:
This steps is crucial to be able to develop and debug scripts in VSCode ans interactivwely
see the results in Blender.

Launch VSCode and go to the Extensions tab, search for Blender Development and install

e Python SEFATR o Get Started with VS Code
P BRI el AT

o

St Up Copllot for Free

of midnight blue dark theme
Moon Violet Dark Plus
Dark Plus Chocolate

G Blends

This will also install some Python related extensions.

6. Test that you can develop python scripts in VSCode for Belnder: Create a sample
blender python file under adirectory for example C:
|Users\falke\Documents\bonsaiDevellscriots. You can use whatever blender nvthon scriot
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you want. We will use this one from the blender documentation:

Example Panel

import

class HelloWorldPanel( . . ):
"""Creates a Panel in the Object properties window"""
= "Hello World Panel"
= "OBJECT_PT _hello"
= 'PROPERTIES'
= '"WINDOW'
= "object"

def draw(self,
= self.

Q)
="Hello world!", ='WORLD_DATA")

Q)

="Active object is: "

Q)

, "name")

Q)

("mesh.primitive cube add")

def register():

def unregister():

if == "_main__"
print("Hello World: run from Blender Text Editor")

else:
print("Hello World: run from VSCode")

print(f"NOTE. _ name__ is : { )

@)

O Tip

Although blender has builtin the python modules for bpy, it is a good practice to install the “fake-bpy-
module” in your local python environment. This will allow VSCode to provide autocompletion and other

features. You can install it by running the following command in the VSCode terminal:
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PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> python3.11 -m pip install fake-bpy-module-latest
Collecting fake-bpy-module-latest
Downloading fake_bpy_module_latest-20250328-py3-none-any.whl.metadata (7.4 kB)
Downloading fake_bpy_module_latest-20250328-py3-none-any.whl (1.1 MB)
1 1.1 eta
Installing collected packages: fake-bpy-module-latest
Successfully installed fake-bpy-module-latest-20250328
PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> D

We have changed the last part of the script since running from VSCode has some subtle
diferences compared to running from the Blender Text Editor. In particular the special
variable __name__ is different.

o Press CTRL-SHIFT-P and type “Blender: Open Scripts Folder”. Select the previous
folder where the script file is located

o Press CTRL-SHIFT-P and type “Blender: Start”. Blender will start.

o Press CTRL-SHIFT-P and type “Blender: Run Script”. The script will run and the output
will be seen in Blender!

As you can see below. We have set a break-point in line 37 (see point 13 below for
another example of setting a break-point). We can inspect in the left side the local
variables, global variables, add watches, check the stack, etc. For example we can see that
__name__ has a value of “<run_path>" Instead of “__main__".

RUN AND DEBUG D BonsaiDocsServer (IfcOpenShell) v &}

\/ VARIABLES

v Locals

>
>
>cl
>

bl_idname = "OBJE

bl_space_type = 'PRO
bl_region_type = 'WI
bl_context = "object"

draw(self, context):
layout = self.layout

obj = context.object

row = layout.row()
row.label(text="Hello world

row = layout.row()

row.label(text="Active object is: " + obj.name)
row = layout.row()

row.prop(obj, "name")

row = layout.row()

row.operator("mesh.primitive_cube_add"

ef register():
bpy.utils.register_class(HelloliorldPane

unregister():
bpy.utils.unregister_class(HellolWor

D 37 if _name__ == "_ main_":

print("Hello World: run from Blend

print(“Hello World: run f
print(f"NOTE

register()

> CALL STACK
 BREAKPOINTS
B Raised Exceptions
¥ Uncaught Exceptions
B User Uncaught Exceptions
¥ example.py
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Once we continue execution we can check in the V5Code lerminal the output and in

Blender the panel created by the script.

oA pror

CONGRATULATIONS! You have now a development environment ready to speedup your
python scripting in Blender.

X. BONUS: Editing Bonsai Documentation: Please refer to Writing documentation for
details on how to edit and contribute documentation. Here we just summarize the steps to
integrate that workflow in VSCode and using Inkscape.

o Download and install Inkscape from Inkscape download page. In our case we will use
Inkscape 1.4 Windows 64 bit msi installer.

o The file below has the style annotation for the Bonsai documentation.

Download style annotation file

It contains some shapes and styles that you can use to create your own diagrams.

(Unsaved) - Blender 4.2.7 LTS

o Open some screenshot file you want to add annotations in Inkscape and also open this
template. You can then copy paste from the template to the screenshot file.
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Warning

When copying the shapes for your convenience just make sure that you do not have selected the option
“When scaling objects, scale the stroke width by the same proportion” to keep the style width right as per

Bonsai documentation style guidelines

# New document 1 - Inkscape

File Edit View Layer Object Path Text Filters Extensions Help

70, [180, [190,

When scaling objects, scale the stroke width by the same proportion

Document Page Selection Custom

Image Size

o Once done you can export your edited screenshot as PNG to be used in the
docummentation. [File - Export..‘] and click in the Export button on bottom right corner.

o As described in Writing documentation you need to have sphinx installed in your
system. One of the easiest ways is to use Chocolately.
Install Chocolately and then you can simply run the following command in the

terminal:

choco install sphinx

and then install the theme and theme dependencies:

python3.11 -m pip install furo
python3.11 -m pip install sphinx-autoapi
python3.11 -m pip install sphinx-copybutton

All these can be accomplished within a terminal of VSCode.
PROBLEMS OUTPUT DEBUG CONSOLE TERMINAL PORTS

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> python3.11 pip install furo

Collecting furo
Using cached furo-2024.8.6- .whl.metadata

o To speedup your workflow you can add the following VSCode files in the .vscode folder

of your cloned repository. In our case itis C:
|\Users\falke\Documents\bonsaiDevelllfcOpenShell\.vscode

o Make sure to edit them with the right paths in your system.

= launch.json

= launch.json

File Edit View

{

// Use IntelliSense to learn about possible attributes.

// Hover to view descriptions of existing attributes.

// For more information, visit: https://go.microsoft.com/fwlink/?1inkid=830387
"version": "0.2.0",

"configurations": [

{

el/IfcOpenShell/src/bonsai/docs/_build/

“preLaunchTask": "
"console": "integratedTerminal™
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Ln1, Col1 635 characters 0% Windows (CRLF)

m tasks.json

E  tasksjson

File  Edit  View

// for the documentation about the tasks.json format
“version": "2.0.0",
"tasks": [

uild and Serve Docs",
ell”,
“powershell”,

-NoProfile",
"-ExecutionPolicy”,
“Bypass”,
had mmand"

"group”: {
"kind": "build",
“isDefault": true

L
"problemMatcher”: []

o Now you can use the debug tool in VSCode to regenerate the html documentation by
cliking the “Play” button BonsaiDocsServer (lfcOpenShell) in the top left corner of the
debug tool.

RUN AND DEBLJK ‘@BOHSSIDO(SSGI\’GV (IfcOpent v {§}
“ VARIABLES

f 1n : Crea

Now let's find out how to interact with GitHub in order to make changes to

6.X **BONUS: Editing r entati : Please refer to
documentation. Here we just summarize the steps to integrate that workfl

- Donwload and install Inkscape from

ontainer blockbutton

- The file above has the style annotation for the Bonsai documentation.

: images/inkscape-annotation-template.png
dth: 1000 px

- Open some screenshot file you want to add annotations in Inkscape and

o Once the server is started you can open a browser and go to the following URL:

http://localhost:8000/ and you will see the documentation.

o In order to rebuild the documentation you need to stop the server and run the
command again. You can do this by clicking in the “Abort” button in the bottom right
corner of the debug tool.
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CONGRATULATIONS! And happy documenting!

Now let’s find out how to interact with GitHub in order to make changes to the Bonsai

project.

7. Install GitHub related VSCode extensions: To facilitate the use of git commands and
pulling and pushing files from a local repository towards github, please install as well the

following VSCode extensions:

o GitHub Pull Requests
o GitHub Repositories

o Remote Repositories

Optionaly you can also install Copilot extensions

o GitHub Copilot
o GitHub Copilot Chat

] File Edit Selection View Go Run

v INSTALLED

Blender Development
2K+ ‘ : ¢
Jacques Lucke

D
C/C++

& Microsoft |
GitHgb Copilot

&G rvH.m

GitHub Copilot Chat
b GitHub

GitHub Pull Requests

Ol.n tHub

GitHub Repositories

a GitHub

Pylance

Terminal
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8. Fork IfcOpenShell project from GitHub: For this step you will need an account on GitHub.
Once you have a registered account you can find it under https://github.com/
YOURGITHUBUSERID In the example for falken10vdl the link is https://github.com/
falken10vdl

= Q falken10vdl Q Type (/] to search

[ overview [J Repositories 1 [ Projects @ Packages ¥ Stars 1

You unlocked new Achievements with private contributions! Show them off by including private contributions in your Profile
in settings.

Popular repositories

Spoon-Knife Public

Forked from octocat/Spoon-Knife
This repo is for demonstration purposes only

@ HTML

falken10vdl 25 contributions in the last year Contribution settings

Go to the IfcOpenShell GitHub page. And click on the Fork button. Please make sure that
you are logged with your GitHub account as shown in the top right corner of the page.

« > C O B8 https://github.com/IfcOpenShell/IfcOpenShell ® 0 O v ® =

= O IfcOpenShell / IfcOpenShell Q Type /]t 3 | v + - ®© n e .
e

<> Code (©) Issues 959 {1 Pullrequests 32 L) Discussions () Actions [J Projects 2 0 wiki @ Security |~ Insights

& IfcOpenShell 9 sponsor s EditPins v ®Wach 91 ~ % Fork 766 Q Yy star 2
Existing forks X

¥ v0.8.0 ~ ¥ 74 Bra Q ) You don't have any forks of this repository.

ary and geometry

@aothms \pDlv sk fra loft 4c2844 ) 17,500 Commits engine

I github dat ) > m
55
aws/lambda
choco/bonsai 1ib onths agc =
cmake
conda
docs
nix
Releases 1,877

pyodide eel Tix < MOntns ag( bonsai-0.8.2-alpha2503201130 ...

Once the fork is generated you will be redirected to your own fork of the IfcOpenShell

project.
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{> Code {1 Pull requests (») Actions 3 Projects I Wiki !) Security |~ Insights o3 Settings

@ Ifcopenshell

forked from

s Pin ®Watch 0 ~

<> Code ~ About

Open source IFC library and geometry
This branch is up to date with

1 Contribute ~ S Syncfork ~ engine

@ aothms A

8 .github

9 17,500 Commits

BB aws/lambda

B choco/bonsai

Now we will clone the forked repository to our local machine.

9. Clone bonsai to our development environment: Launch VSCode Select the Source

Control tool. Then [Clone repository| and then select “Clone from GitHub”.

Provide epository URL o picka repository sourc

@ clone from GitHub

Visual Studio Code

Editing evolved

Start

B— *

Walkthroughs

Get Started with VS Code
0 opentie Custo editor, earn the basics, and start coding @

@ Gittub Copilot [N Welcome to Copilot

& Browse & Edit Remote Repositories without Cloning e

Recent @ Get Started with Python Development [NeW
Youhave no recent folders, opena

@ Get Started with C++ Development e

Signin to Use Copilot for Free

A series of steps will be required to authenticate with GitHub. You will need to provide
your GitHub credentials. Once VSCode has authenticated yourself in GitHub, you will be

able to select the repository you want to clone. In this case we will clone the IfcOpenShell
repository.

) FEile Edit Selection View Go Run Terminal Help

) Welcome x @ falken10vdl/IfcOpenShell

Open source IFC library and geometry engine
(@ falken10vdl/Spoon-Knife https://ait
This r or demonstratior
Open Folder
Clone Repository

and source controlin VS Code read ou

Visual Studio Code
Editing evolved

VSCode will ask you to select a folder where the repository will be cloned. and it will start
the cloning process.

Once finished, you will see the repository in the Explorer tool.
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10. Link the Bonsai addon to the local cloned repository: We will now edit the following
script that establishes links from the unstable-installation to the cloned repository so we
can easily see the changes done in the cloned repository taken effect when we load
blender locally.

Download dev_environment.bat

Edit the file to match the paths in your system. In our case we will edit the following lines:

o SET REPO_PATH=%HOMEDRIVE%\Users\%USERNAME%
\Documents\bonsaiDevel\lfcOpenShell

o SET BLENDER_PATH=%HOMEDRIVE%\Users\%USERNAME%
\AppData\Roaming\Blender Foundation\Blender\4.2

o SET PACKAGE_PATH=%BLENDER_PATH%%\extensions\.local\lib\python3.11\site-
packages

o SET BONSAI_PATH=%BLENDER_PATH%
\extensions\raw_githubusercontent_com\bonsai

You need to run it as an administrator.

Il bonsaiDevel X +
J > Documents > bonsaiDevel > Search bonsaiDevel

| [} I Sort

Copy Rename Share Delete
Open Enter
(& Share
€8 Run as administrator
Add to Favorites
1) Compress to...

Copy as path
> W This PC

&2 Properties

> B Network
Edit in Notepad

Share with Skype

&) Show more options
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Please review if the following is right:
PuD: C:\Windows\Syster
\IfcOpenshell): C fi iDevel \IfcOpenshell
BLENDER PATH: C:\Users\falke\ AppData Roaming\ sl.-naa Foundation\Blender\a.2
PACKAGE PATH ( te local\lib\python3.11\site-packages): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python3.11\sit:
BONSAT PATH ( AT gnhubusermn:enc com\bonsai): C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\d.2\extensions\raw_githubusercontent_com\bonsai

Press any key to continue .
Changing to the Git repository directory
already exists in .gitignore
r compiled IfcOpenshell files.
sers\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib 3.11\site-packages\ifcopenshell\ifcopenshell wrapper.py
falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\ 11\site-packages\ifcopenshell\_ifcopenshell_wrapper i _pyd
2 :

e to Git...

symbolic Link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\e _init__ >> Ci\Users\falke\Documents\bonsaibevel \IfcOpenshel1\src\bonsai\bons

ymbolic link created for L11sit sai < i bonsai\b

rs\falke\AppData\Roaming\Blender Foundation\Blender\d. 2 exte i i copenshell \falke\Documents\bonsaiDevel\IfcOpenshell\src\ifcopenshell-python\ifcopen:

rs\falke\AppData\Roaming\BL a -local\lib\python3 f < sers\falke\Documents \b 1\IfcOpenshell\src\if %

Link created for C:\Users\Ffalke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\ . Local\1ib\python3.11\site- ps\kag fediff.py sers\falke\Docunents \bonsaiDevel\IfcOpenshell\sre\ifcdiFR\ifcdifF. py
ymbolic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\1ib\python3.11\site-packages -y 1\IfcOpenshell\src\bsdd\bsdd.py
lic link created for C:\Users\falke\AppData\Roaming\Blender Foundation\Blender\4.2\extensions\.local\lib\python \Documents bur\:a)De”el \IfcOpenshell\src\bcf\bef
\Users\falke\AppData\Roaning\BLender Foundation\Blender\4.2\extensions\.local\1ib\python3 i s\ifc 5 Devel\IfcOpenshell\src\ifcdd\ifcad
rs\falke\AppData\Roaming\Blender F ions\.local\lib\python3 packag > ent=\bonsaiDevel\TfcOpenshel \erc\iFesd\ifesd
's\falke\AppData\Roaming\Blender F: ¥ tensions\.local\lib\python3.11\site-packages\ifccityjson < A\ nts\bor c\ifccityjson\ifccity]
\Users\Falke\Appbata\Roaming\Blender- Foundation\ELender\a.2\extensions\ . local\Lib\python3. 11\site- packages\ifcclash < \Users\falke\Documents\bonsaiDevel\Ifcopenshell\src\ifcclash\ifcclash
u:sr*S\FalkﬂwppData\Ruam;ng\!—ll ender Foundation\Blender\4. 2\extensions\. local \Lib\python3. 11\site-packages\ifcpatch < \Users\falke\Documents\bonsaiDevel \IfcOpenshel 1\src\ifcpatch\fcpatch
11 \ s

y downloading some third party dependencies...
% Received % Xferd Average Speed Time  Time  Time Current
Dload Upload Total ~Spent
652k -

Time  Time Time
Total Spent  Left
100 18913 013 o ° g )
% Total v rage Speed e Time  Time Current
Dload Upluad Total Spent  Left )peﬂd
e o o o o -- - - -
Failed to open the file C:\Users fans- AppData\Roaming\Blender Fnundat)nmslﬂnder 4.2\ ions\. 1ib\python3.11\site-packages\bonsai\bim\schema\Brick.ttl: No such
jarning: Fxle or axreuor
o 1726k B ) )
) lent rstur‘nnd ERROR on write of 275
any key to continue .

Warning

If you receive errors like this:

The system cannot find the path specified.

It means that you have not installed the Bonsai Blender extension. Please refer to tha last part of point 2.
above and follow the Unstable installation.

Adjust the VSCode Blender extension: We will now make some adjustments to the
VSCode Blender extension to ease the reload of the addon. Select the Extensions tool.

Then |Blender Development| and then select |Settings

Go Run - IfcOpenShell

EXTENSIONS . (] = Settings X

@ext:JacquesLucke.blender-development 13 Settings Found Y
INSTALLED N
User Workspace Backup and Sync Settings

Blender Development -

Extensions
neten Blender: Additional Arguments

Largurr art-up. List of strings

GitHub Copilot Disable

Disable (Workspace)
& GitHub
Auto Update r>Addon: Build Task Name

GitHub Copnmchat
| chat f C e before the a an be loaded into

& GitHub .

Install Specific Version...
GitHub Pull Requests < Uninstall
Pull Reque "

r> Addon: Extensions Repository
# GitHub Copy

>ns only: repository

GitHub Repositories Copy Extension ID > Prefere > G sions ositories (d > right)

Remc y c Copy Link
& GitHub

elopment

Settings}
Pylance r>Addon: Just My Code

) Apply Extension to all Profiles
A performan
# S ug only the sddon. Otherw -pping into external python library code

Add to Workspace Recommendations

Click twice in “Add Item” within the Blender: Additonal Arguments section and add the
following two items (adapt Testing.ifc to the name of the IFC file you want to test during
Bonsai development):

—python-expr
o import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\
\bonsaiDevel\\Testing.ifc”, should_start_fresh_session=True, use_detailed_tooltip=True)

< Settings X

extJacquesLucke.blender-development 13 Settings Found ==

User Workspace Folder v Backup and Sync Settings

Extensions o
Blender

Blender: Additional Arguments

Additional arguments used for Blender start-up. List o
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—python-expr

import bpy; bpy.ops.bim.load_project(filepath="C:\\Users\\falke\\Documents\\bonsaiDevel\\Testing.ifc", should_start_fresh_session=True, use_detailed_tooltip=Trugf X

Add Item
=

/ Note

You can use double backslash (\\) and double quotes (") in the path for correct interpretation by VSCode or
you can use single forward slash (/) and single quotes (') as well. In this case the path will be: ‘C:/Users/

falke/Documents/bonsaiDevel/Testing.ifc’

Blender: Additional Arguments
Additional arguments used for Blender start-up. List of strings.
--debug

--python-expr
import bpy; bpy.ops.bim.load_project(filepath="C:/Users/falke/Documents/bonsaiDevel/Testing.ifc', should_start_fresh_session=True, use_detailed_tooltip=True)

Add Item

Make sure that Blender > Addon: Just My code is not selected (This allows to set the
breakpoints anywhere in the source code).

fcOpenShell

ke.blender-development] 13 Settings Found = Y/
v INSTALLED
Backup and Sync Settings

Blender Development
Tools to simplify Blender development
Jacques Lucke Blender > Addon: Just My Code
y only the code

r
C/C++ 972 pyt

oM
Blender » Addon: Load Directory

B:C|] . GitHub Copilot D28
@ rectory that contains the addon that should be

Warning

This way to use the VSCode Blender extension is not the standard one. Refer to the VSCode Blender
extension documentation for the standard way to use it. The reasond behind is that this allows us to start
VSCode in the top of the cloned repository so all the Git related funtionality in VSCode works properly and
we have a complete view from VSCode tool of the whole repository.

Bonsai is a big project with a lot of dependencies so reloading it it is not an easy task (see discussion in
https://community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1). We have
taken the pragmatic approach to start blender with a specific file (Testing.ifc) and then we can reload the
addon from the Blender Ul which also uploads automatically the changes in the addon and the testing file

To summarize:

o We need Blender > Addon: Just My code to get the breakpoint functionality even if the addon is not
“registered/loaded” to the extension (due to the root folder we use)

o We need Blender: Additonal Arguments to automatically load the Testing.ifc file when we start Blender
from VSCode (We do not use Blender:Reload Addons since it does not work in our case)

Instead of restarting Blender from VSCode, we use the Blender Ul that, as explainedin the next step, it
provides a simple way to get the addon and the Testing file reloaded.

12. Launch blender from VSCode: We are now ready to launch Blender from VSCode. Open
VSCode. Open the cloned repository if not already open. Press CTRL-SHIFT-P and type
“Blender: Start”.

BODBEO0 - O X

g -



http://localhost:8000/_images/VSCode-blender-additional-arguments-windows.png
http://localhost:8000/_images/VSCode-blender-additional-arguments-windows.png
http://localhost:8000/_images/VSCode-blender-additional-arguments-2-windows.png
http://localhost:8000/_images/VSCode-blender-additional-arguments-2-windows.png
http://localhost:8000/_images/just-my-code-false.png
http://localhost:8000/_images/just-my-code-false.png
https://github.com/JacquesLucke/blender_vscode
https://github.com/JacquesLucke/blender_vscode
https://github.com/JacquesLucke/blender_vscode
https://github.com/JacquesLucke/blender_vscode
https://community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1
https://community.osarch.org/discussion/1650/vscode-and-jacquesluckes-blender-vscode/p1
http://localhost:8000/_images/VSCode-blender-start.png
http://localhost:8000/_images/VSCode-blender-start.png

* IFCOPENSHELL
> .github
> aws
> choco
> cmake
> conda
> docs
nix

> pyodide

£ .clang-format

£ clang-tidy
git-blame-ignore-revs
gitignore
gitmodules

R COPYING

£ COPYING.LESSER
Dockerfile
pyproject.toml
README.md
VERSION

> OUTLINE
> TIMELINE
X §°v080: & ®0AO

without C Debugger
Blender: Build
Blender: Build Python API Docs
Debug: Select and Start Debugging
Pylance: Start Profiling
Pylance: Start Logging
Debug: Start Debugging
Help: Welcome

Ask GitHub Copilot: Blender:Start

Recent

You have no recent folders,

Walkthroughs

™ Get started with VS Code

Customize your editor, learn the basics, and start coding
@ GitHub Copilot [New
B) Browse & Edit Remote Repositories without Cloning [New!
@ Get Started with Python Development (e

@ Get Started with C++ Development [New

/ Show welcome page on startup

Blender will start loading the Testing.ifc file. You can now start exploring the code and

make changes to the addon!
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In order to be able to restart blender (and reload the addons + reload the Testing file) we

need to enable “Developer Extras” and also a good practice is to enable “Python Tooltips”

in |Edit » Preferences » | ace|.

Interface
Viewport
Lights
Editing
Animation

Get Extensions

Add-ons

LLENES

Input
Navigation

Keymap

System
Save & Load

File Paths

Experimental

Blender Preferences

v Display

Resolution Scale
Line Width

Tooltips

1.00
Default
« Splash Screen

« Developer Extras

« User Tooltips

« Python Tooltips

Search

v Editors

Color Picker Type
Header Position
Factor Display Type
> Temporary Editors
> Status Bar

v Language

Language

« Sort by Most Recent

+ Region Overlap

+ Navigation Controls
Circle (HSV)
Keep Existing

Factor

English (English)
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Once these are enabled, you can press F3 and write “restart” to restart Blender.

(Unsaved) - Blender 4.2.8 LTS

D File Edit Render Window Help Y BIM &5+ Scene W ViewLayer [T

. 0O Vv § #2v W ObjectMode v View Select Add Object 13 Global v (Pv §@ Mix v (s e R @ T OO0 - B FcobjectModev | ps scene
T Scene Collection il Fa = Options
& Collection Lol o] . o0y xTLD
- User Perspective
& IfcProject/Projekt-FZK-H @ © @ (1) IfcBuildingStorey/Erdgeschoss & Project Overview
v (@ IfcBuildingStorey/Erdg @ © @
nnotation/Unn @ @ ) « Project Info
notation/Unn ~ © @
IfcAnnotation/Unn @ @
IfcAnnotation/Unn ~ © B (% IFCSchema  IFC4
IfcAnnotation/Unn @ @ &1 IFC MVD , Quantity...ew]Option
TfcAnnotation/Unn @ @
TfcAnnotation/Unn @ @
TfcAnnotation/Unn @ @
IfcAnnotation/Unn ~ © @ > Git
IicAnnotation/Unn ~ © &1

IfcAnnotation/Unn ~ © &
o \ Spatial Decomposition

] Testing.ifc

1, Saved 2016-12-2117:54

PN

W

»

v

- Spatial

A

IfcAnnotation/Unn
IicBeam/Unterzug @ @ & Default: Erdgeschoss
IfcBuildingStorey/l © @
IfcDoor/Haustuer °on
IfcDoor/Innentuer  © @
IfcDoor/Innentuer @ @
IfcDoor/Innentuer @ @
IfcDoor/Terrassen @ @
IfcSlab/Bodenplatit @ @
IfcStair/Wendeltre © @
IfcWallStandardC:  © @
IfcWallStandardC:
IfcWallStandardC:
IfcWallStandardC:
IfcWallStandardC:
IfcWallStandardC:
IfcWallStandardC:
‘cWallStandardC:

IfcBuilding

] Projekt-FZK-Haus
v & Gelaende
v & FZK-Haus
v = Er. ACID.
O1 Flur
O 2 Buero
3 Bad
4 Schia..
5 Wohn...
6 Kiiche
Restart Blender v
Restore Key Mante) e
Clear All Rest Blender will be immediately restarted, save your data first before running this operator. ~ gnts
rrence
TfcWindow/EG-Fel
IfcWindow/EG-Fel

Disable Editing Resource Time
Edit Representation Item Style

NSO IRr= ¢

Enable Editing Resource Time

55 Add Grids
Reference Structure

TfcWindow/EG-Fel Reload Drawing Styles v Project Setup
IfcWindow/EG-Fei Remove Drawmvg Style
IfcWindow

IfcWindow/ \ S22 V4 > Links

IfcWindow > buildingSMART Data Dictionary

> Project Library

IfcBuildingStorey/Dacl > Classifications.
TfcAnnotation/Unn 5 Libraries
TfcAnnotation/Unn o

in
IfcBeam/First » Constraints

TfcBeam/Pfette-1 > Documents

IfcBeam/Pfette-2 > Property Set Templates
IfcBuildingStorey/!
IicMember/Sparre S
TfcMember/Sparre itz
TfcMember/Sparre > Georeferencing
> Geometric Representation Contexts
Icher bel > Space Boundaries
TfcMember/Sparre
TfcMember/Sparre oSl
TfcMember/Sparre + Grouping and Filtering
TfcMember/Sparre  Search
IfcMember/Sparre
IfcMember/Sparre 0 Saved Searches
TfcMember/Sparre + Add Search Group.
IicMember/Sparre
 Filter Selection
IicMember/Sparre
TicMember/Sparre
IfcMember/Sparre
IfcMember/Sparre » CE Ry
> Select Similar
IfcMember/Sparre > Groups
TfcMember/Sparre
TfcMember/Sparre
TfcMember/Sparre
TfcMember/Sparre
TfcMember/Sparre
TfcMember/Sparre
IfcMember/Sparre
IfcMember/Sparre
IicMember/Sparre
IfcMember/Sparre
IfcMember/Sparre

/" Note

The Windows conpty DU will force the terminal to be detached once Blender is restarted and yo
lose the console output. In order to avoid that, you can enable the following settings in VSCode:

Go to | File » Preferences » Settings | and search for “terminal.integrated.windows”. Enable both

terminal.integrated.windowsEnableConpty and terminal.integrated.windowsUseConptyDIL.

£ windows_ide.rst I < Settings X

terminal.integrated.windows 10 Settings Found
e
User Workspace Backup and Sync Settings

Features o
€%  Terminal > Integrated: Windows Enable Conpty
Terminal

s terminal process communication (requires Wind 10 build numbe
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Terminal > Integrated: Windows Use Conpty DIl ' Preview

Whether to use the experimental conpty.dll (v1.22.250204002) shipped with VS Code, instead of the one bundled with

Windows.

Terminal > Integrated > Automation Profile: Windows

The terminal profile to use for automation-related terminal usage like tasks and debug. This setting will currently be ignored if

terminal. integrated. automationShell.windows (now deprecated) is set

o terminal.integrated.windowsEnableConpty makes it possible to restart blender from Bonsai
restart_blender command.

e terminal.integrated.windowsUseConptyDIll makes it possible to maintain the console attached so the
output of the reloaded blender instance is still visible in the terminal.

13. Add a break-point: Let's add a break-point in the code to see how it works. Press CTRL-
SHIFT-P and type “Blender: Start”. Blender will start. Open the cloned folder and go to src
> bonsai > bonsai > bim > module > ligth > prop.py and go to line 75. Add a line for a print
statemente and click on the left side of the line number to add a break-point.

def update_shadow_mode(self,
print("Shadow mode", self.
if self. "SHADING" :

Set a break-point in line 75.

o
a
a
a
a
a
a
a
a
a
a
a
a
o
a
a
o
on

In Blender. Go To SOLAR ANALYSIS Tool in Bonsai and Click in “No Shadow”, “Shaded” or
“Rendered”

2 File Edit Render Window Help &5+ Scene 1] & viewLayer (O

W, ObjectMode v View Select Add Object 2 Global v (Pv § Mix v (s CrR @ T g scene

L0 =
User Perspective

(1) IfcBuildingStorey/Erdgeschoss ® Services and Systems

A0 Options v

t/Projekt @ ©
JildingStc @ ©
fcAnnot v Services

> Systems
v Zones

& 0Zones Found

v Solar Analysis

Sites: Gelaende - 49.1,8.437
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Coordinat... 49°06'01.56"N 08°26'11.5

V IfcAnnota =

IfcAnnotal Latitude 49.10 Longitude B.44
IfcAnnotal True North

IfcBeam/L
IfcBuilding

/ IfcDoor/H  © B

Year
January 1 Date

Hour 12 Minute

Europe/Berlin
&5 Scene
Local Time: 12:00:00  Sunrise: 08:20:43

- .
SoOYymIA UTC Time: 11:00:00  Sunset: 16:39:18

€8 Project Overview ¥% DisplaySunPath  SunPath.. 50.00

v Grouping and Fittering (@ |[NoShadows ' @ shaded ) Rendered

v Search N View From Sun

0 Saved Searches L v Lighting

+ AddSearchGroup Y/ > Radiance Exporter

v Filter Selection

> Colour By Property

> Select Similar

fcOpenShell

P No Configurations

LdLLUNY(SELT, LUILEXL):
VARIABLES

v Locals

update hourminute(self, context):
update sun path( )

update date(self, context):
update sun_path( )

update true north(self, context):
update sun_path( )

update sun path size(self, context):
update sun_path( )

update shadow mode(self, context):
print(“Shadow [ .shadow mode)
f .shadow_mode == HADING

update sun path( )

context.scene.render.engine = "BLENDEF

context.scene.display.shading.light =

context.scene.display.shading.show shadows =

context.scene.display.shading.show object outline =

context.scene.display.shadow focus = 1.0

context.scene.view_settings.view transform =

space = tool.Blender.get view3d space()

space.shading.type = ENDER

.shadow_mode == ENDERING

context.scene.sun_pos_properties.sun_object
bpy.ops.object.light add(type="SUN", radius=1, align="WO0
bpy.ops.object.move to collection(collection_index=0)
context.scene.sun_pos properties.sun object = bpy.context.a

update sun path( )

context.scene.render.engine = "BLEl

context.scene.display.shading.light

rantavt crana dienlav chadina chau chadaue —

34

Process context filter

Calculate model offset

Set units :: 0.00

Create project :: 0.00

Process element filter

Create styles :: 0.00

Parsing native elements

Done creating geometry

Create native elements

Done creating geometry

0 / 3 elements processed

Create elements :: 0.47
update_shadow_mode prop.py (75 Done creating geometry

Thread-1 (server_thread_function) AUSE 0 / 2 elements processed

Create annotations :: 0.03

serve forever . Create positioning elements :: 0.00

Done creating geometry

0 / 3 elements processed

aun 25 Create spatial elements :: 0.02

server_thread_function 42 Create structural items :: 0.00

Create element types :: 0.01
Place objects in collections

Setup arrays :: 0.00

BREAKPOINTS Load linked models :: 0.00

@ Raised Exceptions Add project to scene :: 0.00
Setting default context :: 0.04
Import finished in 0.64 seconds

Warning: File written by newer Blender binary (403.34), expect loss of data!

CALL STACK
MainThread

run_simple

B Uncaught Exceptions
@ User Uncaught Exceptions

) File Edit Selection View Go Run Terminal Help

D BonsaiDocv {3 E windows_ide.rst M c\ fe 11\site-p

VARIABLES get_sites(self, context)

/ Locals

update_latlong(self, context)
update_sun_path(self)

> Globals
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update_date(self, context)
update_sun_path( )

update_true_north(self, context):
update_sun_path( )

update_sun_path_size(self, context):
update_sun_path(

update_shadow_mode(self, context):
print("Updating shadow mode", .shadow_mode)
shadow_mode ==
update_sun_path( )
context.scene.render. engine =
context.scene.display.shading.light =
context.scene.display.shading.show_shadows =
context.scene.display.shading. show_object_outline =
context.scene.display. shadow_focus = 1.0
context.scene.view_settings.view_transform =
space = tool.Blender.get_view3d_space()
space.shading.type = "REN )
shadow_mode !
if context.scene.sun_pos_properties.sun_object
bpy.ops.object.light_add(type="SUN", radius=1, align= , location=(e, @, @), scale=(1, 1, 1
bpy.ops.object.move_to_collection(collection_index=0)
context. scene.sun_pos_properties.sun_object = bpy.context.active_object
update_sun_path(self)
context.scene.render.engine = ) |
context.scene.display.shading.light = "F
context.s . ay.shading.show_shadows =
context.scene.display.shading. show_object_outline =
context.scene.display.shadow_focus = 1.0
context.scene.view_settings.view_transform = "Standal
space = tool.Blender.get_view3d_space()

update_shadow_mode(self, context):

print ("l ing shadow mode" elf.shadow mode)

if self.shadow_mode == "SHADING":
update_sun_path(self)

context.scene.render.engine =
context.scene.display.shading.light = "FLA
context.scene.display.shading.show_shadows =
context.scene.display.shading.show_object_outline =
context.scene.display.shadow_focus = 1.0
context.scene.view_settings.view_transform =
space = tool.Blender.get_view3d_space()
space.shading.type = "RENDERED
elif .shadow_mode ==
if context.scene.sun_pos_properties.sun_object
bpy.ops.object.light_add(type="SUN", radius=1, align="WORLD", location=(@, @, @), scale=(1, 1, 1))
bpy.ops.object.move_to_collection(collection_index=8)
context.scene.sun_pos_properties.sun_object = bpy.context.active_object
update_sun_path( f)
context.scene.display.shading.light = "
context.scene.display.shading.show_shadows
context.scene.display.shading.show_object_outline =
context.scene.display.shadow_focus = 1.0
context.scene.view_settings.view_transform =
space = tool.Blender.get_view3d_space()

context.scene.render.engine =

TERMINAL { “+ v

) ) &) emd
Parsing na‘Flve elements :: 9.0 i ——
Done creating geometry
Create native elements :: ©.00
Done creating geometry
Create elements :: 0.02
Create annotations :: ©.8@

Create positioning elements ::
@ / 3 elements processed ...
Create spatial elements :: ©.00
Create structural items :: ©.00
Create element types :: ©.00
Place objects in collections ::
Setup arrays :: 90.00

Load linked models :: ©.00

Add project to scene :: ©.00
Setting default context :: ©.07
Import finished in ©.13 seconds

|Updating shadow mode NONE |

From here you can watch the local variables, global variables, add watches, check the
stack, etc. Resume execution or move step by step to see how the code is executed.

CONGRATULATIONS! You have now a development environment ready to explore the
Bonsai code and contribute to the project.

14. Make changes and do a Pull Request to the project: In the previous steps we got a
complete IDE to explore and make changes to the Bonsai sourcecode. In this step we will
provide a simple workflow of using Git commands within VSCode to make changes and
do a Pull Request to the project. Bonsai changes very fast so our cloned repository will be
outdated very soon. We propose to do the following:
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a. Check in our GitHub page if our project fork (https://github.com/falken10vdl/
IfcOpenShell) is outdated compared to the [fcOpenShell main branch (https://
github.com/IfcOpenShell/IfcOpenShell).

b. Sync our fork with the upstream branch (if needed).

c. Pull the changes in our porject fork to our local repository (/home/falken10vdl/

bonsaiDevel).
d. Create a new branch in our local repository (example: DOC_QS_IDE)
. Publish the branch to our project fork in GitHub.

D

f. Make changes in the code.

. Commit the changes.

> Q@

. Push the changes to our project fork.

i. Create a Pull Request to the upstream main branch of the [fcOpenShell project.

Let’s see below the steps with an example of changing the documentation of the
Quickstart guide for the IDE in Windows.

a. Check in our GitHub page if our project fork is outdated. Click Update branch
€« > C © & httpsiigithub.comfalken1ovdl/ifcOpenshell
= o falken10vdI IfcOpensShell

> Code 11 Pullrequests ») Actions 3 Projects 0 wiki Security Insights & Settings

@ Ifcopenshell £ Pin  ®Wach 0 -

forked from

P 1 0Ta ) ) t + <> Code ~ About

Open source IFC library and geometry
{1l Contribute ~ O Syncfork ~ engine
al

$o This branch is out-of-date

@ aothms

m github

I aws/lambda
choco/bonsai

Compare
cmake P

conda ) Update branch

docs

Releases

nix t Packages

pyodide
b. After clicking Update branch our fork is up to date with the upstream main branch.
« > C QO B https://github.com/falken10vd
O falken10vdI IfcOpenShell

> Code {7 Pull requests ») Actions 1] Projects 0 wiki Security |~ Insights 93 Settings

@ Ifcopenshell o ® Watch 0 -

forked from

¥ v0.80 - $ 1 Branch © Q t + <> Code ~ About

Open source IFC library and geometry

This branch is up to date with . Il Contribute ~ G Syncfork - engine

BO0ED - o x
= Settings X a8 -
CHANGES
GRAPH [ ifcOpenshell §° Auto @ ucke.blender-development 13 Settings Found = /'
Apply skew ininfra lofts #6386
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ISSUE #6328 fix in dispatch
Retrieve length unit info from underlying mapping in iterator
ifcsverchok - ifc

te_file_panel to filter .ifc files

node.sv_ifc_create_file_refresh - fix LB Out bl_label
ifcsverchok - remove debug print Andr

node.sv_ifc_tooltip - hide title
typing

Read settings from

d. Create a new branch in our local

Blender: Additional Arguments

Additional arguments used for Blender start-up. L

python-expr
import bpy; bpy

ops.bim.load_project(filepath="/home/falken10vd|/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_toolj

Add Item

epository by clicking in the current branch name in the

bottom left corner of the VSCode window. Give a name to the branch and press Enter.

) File Edit Selection View Go Run Terminal Help

DOC.0s IDE

SOURCE CONTROL

> CHANGES

 GRAPH B ifcopenshell Ao @ ¥ ¥ & O
O Fix Blender 4.4 errors starting some operators. .. @00 @ U
ser

The experimental cutting tool now supports a bisect mode fo.. -

5

Minor fix to clipping planes if there is no camera [
pPing p v Extensions

See #6404. See #1227. Create axis context if it does not exist
Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall .

Blender (13

Some form of circle handling in loop_to_function_item_upgr
Apply skew in infra lofts #6386 rifr

ISSUE #6328 fix in dispatch_token to avoid missing unknown
Retrieve length unit info from underlying mapping in iterator
ifcsverchok - ifc.write_file_panel to filter .ifc files Andrej73
node.sv_ifc_create_file_refresh - fix LB Out bl_label
ifcsverchok - remove debug print A

node.sv_ifc_tooltip - hide title

typing

Read settings from argparser

pyodide demo: install shapely

Update publish-pyodide-demo-app.yml Th

Update wheels #6402

Blender 4.4 - fix broken Ul lists #6396

Implement readable setting type retrieval Thomas Krijn:
Reinstate old bespoke model-offset/rotation parsing in IfcCo.
Normalize model-rotation quaternion The j

Bonsai makefile - fill last_commit_date... A 3

Fix missing default value for "last_commit_date" (37ec2bf) #
Use explicit *bl_ui_utils.layout™ import to fix #6389... A
debugging docs - add section about debugging addon

get distance along alignment from station hard Br

See #1227. Fix bug where unjoin walls didn't recheck the posi...
Fix #6318. Fix warnings when decorator cannot convert 3D to
Quantification to consider Pset_ProfileMechanical.MassPerLe
quantification fallback - small clarification A

typing

black. And

Issue #5130 fix + sheet all expand and contract (#6379)..

Fix #6372. See #1227. More reliable layer slicing. Always slice
See #1227. Clear cache when activating drawings. Dion Moult
get_shape_aspects to consider element's type #6374..

Fix Ul errors in case of uppercase unit names (7af6727).

+ Create new branc

7 Checkout detached

Workspace

BoEO -
QB8

o X

~+ Create new branch from...

13 Settings Found Y

Backup and Sync Settings

Blender: Additional Arguments
Additional arguments used for Blender start-up. List of strings.
python-expr
import bpy; bpy.ops.bim.load_project(filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool|

Add Item

Blender > Addon: Build Task Name

Task that should be executed before the addon can be loaded into Blender

Blender > Addon: Extensions Repository
Blel
Ble

r extensions only: repository vhen developing add

r -> Preferences -> Get Extensions -> Repositories (dropdown, top right)

vscode_development

Blender > Addon: Just My Code

If true, debug only the code in this addon. Otherwise, allow stepping into external python library code:

Blender > Addon: Load Directory

Directory that contains the addon that should be loaded into Blender.

auto

Blender > Addon: Module Name

Name or the symlink that is created in Blenders addon folder

Filter

The new branch is created and we can see it in the bottom Lleft corner of the VSCode

window.

expan

Fix #6372. See #1227. More reliable layer slicing. Alv
See #1227. Clear cache when activating drawings.

get_shape_aspects to consider element's type #6374...

L (Git) - Publish Branch 'S unit names (7af6727)...

IfcOpenShe

$° DOC_QS_IDE* &

P Y alaTala)!

®OAO0

e. Publish the branch to our project fork in GitHub by clicking in the publish button (little

cloud with up arrow) in the bottom left corner of the VSCode window. Select as origin
the project fork.

) File Edit Selection View Go Run Terminal Help

SOURCE CONTROL /github.com/falkeni0vdl/IfcOpenShelLgit

origin  http:
upstream hu ell/IfcOpensh
~+ Add a new remote.

> CHANGES

13 Settings Found Y

 GRAPH B fcopenshell Ao @ ¥ ¥ D O
Fix Blender 4.4 errors starting some op... (SIBOCIGSHDE &

User  Workspace Backup and Sync Settings

The experimental cutting tool now supports a bisect mode fo...

)

Minor fix to clipping planes if there is no camera [ VR
See #6404. See #1227. Create axis context if it does not exist .. Blender: Additional Arguments

Fix #6404. See #1227. Fix IFC2X3 wall creation with new wall

Blender (13

Additional arguments used for Blender start-up. List of strings.

Some form of circle handling in loop_to_function_item_upgr
python-expr
Apply skew in infra lofts #6386 L) i
Sy import bpy; bpy.ops.bim.load_project{filepath="/home/falken10vdl/bonsaiDevel/Testing.ifc", should_start_fresh_session=True, use_detailed_tool]
ISSUE #6328 fix in dispatch_token to avoid missing unknown

Retrieve length unit info from underlying mapping in iterator ... Add Item

ifesverchok - ifc.write_file_panel to filter .ifc files rej

node.sv_ifc_create_file_refresh - fix LB Out bl_label A )
Blender > Addon: Build Task Name
ifcsverchok - remove debug print An
re the addon can be loaded into Blender

Task that should be executed t

node.sv_ifc_tooltip - hide title
typing And

Read settings from argparser
oyl e sl Blender > Addon: Extensions Repository
Update publish-pyodide-demo-app.yml
Update wheels #6402

Blender 4.4 - fix broken Ul lists #6396

Blender extensions only: repository to use when developing addon

Blender -> Preferences -> Get Extensions -> Repositories (dropdown, top right)

Implement readable setting type retrieval. Thomas Krin: i

Reinstate old bespoke model-offset/rotation parsing in IfcCo.
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Bonsai makefile - fill last_commit_date... A If true, debug only the code in this addon. Otherwise, allow stepping into external python library code.
Fix missing default value for *last_commit_date" (37ec2bf) #.

Use explicit *blLui_utils.layout" import to fix #6389...

@ debugging docs - add section about debugging addon BicnceipAddon Load D ectory

L et g e e GGt e, EdimlE: Directory that contains the addon that should be loaded into Blender
See #1227. Fix bug where unjoin walls didn't recheck the posi auto
Fix #6318. Fix warnings when decorator cannot convert 3D to.
® Quantification to consider Pset_ProfileMechanical.MassPerLe..
Blender > Addon: Module Name
® quantification fallback - small clarification
typing Andrej730 Name or the symlink that is created in Blenders addon folder
black - ter
® Issue #5130 fix + sheet all expand and contract (#6379)
® Fix#6372. See #1227. More reliable layer slicing. Always slice ...
See #1227. Clear cache when activating drawings. Dion Moult
get_shape_aspects to consider element's type #6374... Andr..

Fix Ul errors in case of uppercase unit names (7af6727)... And...

3 DOC_G5_IDE|(®) ®0A0

Check that the branch is now in our project fork in GitHub.

B O falken10vdl/IfcOpenShell X +
& - © O 8 https://github.com/falken10vd|/IfcOpenShell
5 AlmaLinux {* Documentation {*Blog f* Bug tracker % GitHub organization
O falken10vdl / IfcOpenShell Q Ty

<> Code {7 Pullrequests (» Actions [J Projects [0 Wiki @ Security |~ Insights 3 Settings

@ Ifcopenshell oo P @wach 0 ~

forked from

¥ v0.8.0 ~ ¥ 2 Branches © 0 Tag; Go to Add file ~ <> Code ~ About

Open source IFC library and geometry
engine

Switch branches/tags »
{9 Contribute ~ Sync fork ~

Q Find or create a branct
Branches | Tags ne operators 228 1 7,506 Commits s LGPL-3.0 license
A~ Activity
v v0.8.0 default Jpdate publish-pyodide-demo-app.yr ?
Yy O stars
grate docs urls 1
migrate docs u © Owatching
k4

View all branches bonsaibim u 0 fork

B cmake Don't allow empty sha for add_commit_sha
Releases

conda bonsaibim urls 7 months ag

es pt
docs docs: include doxygen-awesome as git submodule 11 months ago
nix date build-all.py; --fo hen fetch tags last month Packages
pyodide w wheel fixes 2 months ago

src X 1 ors starting some operators
Languages
test Unify variant storage ( I 7 months ago

win Fetch boost from github releases in build scripts 2 months ago ® C++76.2% Python 20.1%
€ 2.6% Gherkin 0.4%
.clang-format clang-format: remove duplicates from base sty € ® javascript 0.2% @ SWIG 0.1%

® Other 0.4%

]
]
]
]
]
]
B
B

.clang-tidy clang-tidy: add basic checks 2 years ago

f. Make changes in the code. In this case we will change documentation by adding a
Quickstart for the IDE in Windows. :)

* UNTITLED (WORKSPACE)
© IfcOpenshel e : In the previous steps we got a complete IDE to explore and make changes to the Bonsai sourcecode
d. Create a new branch in our local repository by clicking in the current branch name in the bottom left corner of the VSCode window. Give a name to the branch and press Enter
images/new-branch-local.png
dth: 1000 px

Publish the branch to our project fork in GitHub by clicking in the publish button (*Little cloud with up arrow?) in the bottom
left corner of the VSCode window. Select as origin the project fork
 annotation.svg

ge: : images/new-branch-publish-to-private-github.png

wironmentsh idth: 1000 px

Check that the branch is now in our project fork in GitHub,

images/new-branch-in-private-github. png
h: 1088 px

Make changes in the code. In this case we will change documentation by adding a Quickstart for the IDE in Windows

images/make-changes..png
h: 1068 p

= next steps. £. Commit the changes

> reference First provide your user name and email to Git.

age:: inages/git-user-enail.png
dth: 1000 px

Then conmit the changes by clicking in the check mark in the Source Control tool

mage:: images/comnit-changes.png

£ requirements.txt

> saipts

g. Commit the changes.

First provide your user name and email to Git (this is required only once).

TERMINAL

PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell>|git config user.email
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PS C:\Users\falke\Documents\bonsaiDevel\IfcOpenShell> j

Then commit the changes by clicking in the check mark in the Source Control tool.

File Edit Selection View Go Run Terminal Help

SOURCE CONTROL

v CHANGES

Add quickstart for Windows 1D

@ v/ Commit
v Changes

Accept the staging of the changes prior to commit.

Visual Studio Code

There are no staged changes to commit.

Would you like to stage all your changes and commit them directly?

Never Always Cancel Yes

h. Push the changes to our new branch in the github project fork.

it Selection View Go Run Terminal Help IfcOpenShell

SOURCE CONTROL es = index.rst X

\ CHANGES dex.rst

> IfcOpenShell ¢ ¥ pC DE* 1r 118% builder html and (not singlehtml)
nt r: toc-cards

> input
inpu global-index-toc

> mvd
> svfill
v Sample-BIM-Files
Quickstart
2

quickstart/introduction to bim
v cityjson 19488c8d O 1 () oo quickstart/installation
quickstart/explore model

Check that the changes are in the project fork in GitHub. You can see that the directory
ide has been added, for example.

= O falken10vdl / IfcOpenShell t &3 t v OMR YRRE~' .

<> Code 7 Pullrequests () Actions (] Projects [0 wiki @ Security |~ Insights 8 Settings

[ Files ) ‘ quickstart / (& Add file ~

> DOCGsS... . falken10vdl I qu t for Wind ! O History

fil
This branch is

1) Contribute ~ & Sync fork ~

ide

nix -
images
> @ pyodide
- [ src

> BB bef h | explore_model.rst

] create_model.rst

v [ bonsai installation.rst
> [ bonsai \ - . ]
introduction_to_bim.rst
> @ build

& d 9 next steps.rst
v ocs
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i. Create a Pull Request to the upstream main branch of the [fcOpenShell project. Go to
your GitHub page and you will see that the new branch has 1 commit ahead of the
upstream main branch. Click in the Compare & pull request button.

« > C QO 8 https://github.com/falken10vdl/IfcOpenShell/tree/DOC_QS_IDE

= O falken10vd| IfcOpenshell

Code I Pullrequests () Actions [ Projects [ Wiki Security 7 Insights 3 Settings

@ Ifcopenshell % Pin

forked from

¥ DOC_QS_IDE had recent pushes 36 minutes ago Compare & pull request About
T —

Open source IFC library and geometry

engine
% DOCQSIDE -~ ¥ 2Brar C f + | <> Code ~

® Watch 0 ~

o

BT i1 Contribute ~ O Syncfork ~ & LGF

. falken1ovdl Ad O 17,507 Commits

Verify that the changes are correct, add a description and click in the Create pull
request button.

« - C O B https://github.com/IfcOpenShell/IfcOpe ¢/v0.8.0...falken10vdL:IfcOpenShe

— O IfcOpenShell IfcOpenShell

<> Code () Issues 962 {1 Pullrequests 32 ) Discussions ») Actions [ Projects 2 0 wiki Security Insights

Comparing changes

IfcOpenShell/IfcOpenShell ¥ ory: falken10vdl/IfcOpenShell ¥ compare: DOC_QS_IDE ¥

Add a title
Helpful resources

Add quickstart

Add a description

Write Previev H B Z = = = bE

This is documentation with all the steps required to implement a simple yet powerful IDE workflow to work with Bonsai
Sourcecode

I Markdown is supported A Paste, drop, or click to add files

¥ Allow edits by maintainers 2) || Create pull request -

CONGRATULATIONS! You have now made a change in the Bonsai project and created a
Pull Request to the main branch of the project. Happy coding and documenting!

Copyright © 2020-2024 IfcOpenShell Contributors
Made with Sphinx and @pradyunsg's Furo


http://localhost:8000/_images/private-fork-new-branch-updated-windows.png
http://localhost:8000/_images/private-fork-new-branch-updated-windows.png
http://localhost:8000/_images/compare-and-pull-request.png
http://localhost:8000/_images/compare-and-pull-request.png
http://localhost:8000/_images/pull-request-windows.png
http://localhost:8000/_images/pull-request-windows.png
https://www.sphinx-doc.org/
https://www.sphinx-doc.org/
https://pradyunsg.me/
https://pradyunsg.me/
https://github.com/pradyunsg/furo
https://github.com/pradyunsg/furo
https://ifcopenshell.org/
https://ifcopenshell.org/
https://github.com/IfcOpenShell/IfcOpenShell/tree/v0.8.0/src/bonsai/docs
https://github.com/IfcOpenShell/IfcOpenShell/tree/v0.8.0/src/bonsai/docs

